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VI5194-L Many architectural structures incorporate a water feature as a prominent visual 

component of the structure. This exciting class explains how to implement 3ds Max Particle 
Flow for architectural use. This class takes you through the creating water fountains, 
waterfalls, and other water features architects like to use. We will cover creating particle flow 
networks to simulate water flow and using space warps to affect the motion of the particles. 
We will also cover the point cache and particle rendering. 

Learning Objectives 
At the end of this class, you will be able to: 

 Create particle flows to simulate fountains and other water features. 

 Use space warps to create custom effects with particle flows. 

 Add point cache to effectively work with large numbers of particles. 

 Apply materials and render particle systems using the mental ray® renderer. 

 

About the Speaker 
Steven attended R.I.T.'s film/animation in 1989 & A-B Tech's Entrepreneurship in 2011. 

Opened Spectralight Images in 1989 to deliver 3D training and animation. Moved to Orlando, 

FL in 1990. As VP of Computer Animators Plus (1995) began teaching 3D at Seminole State 

College. With a love of art, opened Gallery 611 in 1997, and formed the Orlando Visual Artists 

League in 2000, president until 2004. In 1998 he became an Autodesk® training specialist, 

and has contributed to Autodesk's certified training material for 9 releases of 3ds Max®. He 

was a co-developer of Autodesk's ACI Program, and Autodesk's 3ds Max® fundamental 

standards. Now he develops 3ds Max / Maya training courseware for CAD Learning's online 

training. Spectra3D Technologies provides 3ds Max, Maya & AutoCAD training. Steven 

teaches classes for end users, companies, Autodesk University, & others. Past trainees: 

Disney, Guess, US Army, and more. In 2014 Spectra3D Technologies expanded into 3D 

printer sales and support offering an array of 3D printers, design services and 3D printing 

training. 
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Step by Step 

Configuring the Collision Objects 
1. Open 09_Pflow_Fountain_01.max. 

2. Select the Granite Sphere object in the middle of the fountain. 

3. In the Command panel, click the Modify tab. 

4. Expand the Modifier List drop-down and choose the PFlow Collision Shape World Space 
Modifier. 

5. Set the Restitution to a value of 0.5. 

6. Keep the friction extremely low; set the value for the Static Friction to 0.1.  

7. Set the Dynamic Friction to 0.1 as well. This will allow particles to gently slide along the surface 
of the sphere. 

8. Before activating this modifier, make sure the Shape is set to Sphere. This will use a 
mathematically defined sphere to calculate the collisions. 

9. Once those options are set, click Activate to turn this into an active Particle Flow simulation 
object. 

10. Click the Create Panel, Spacewarps, then select Deflectors from the Spacewarps dropdown. 

11. Select the UDeflector object type. 

12. In the Fountain_Cam viewport, click and drag to create a UDeflector Object. 

13. Change the Modify panel.. 

14. In the UDeflector Basic Parameters, Click the Pick Object button and select the Fountain Water 
object that is in the fountain. 

15. Set the Bounce value to 0.3. 

16. Change the Friction value to 0.6. 

Creating a Particle Flow 

To start here use: 09_Pflow_Fountain_02.max 

Add a PFlow object 
1. In the Command panel, click the Create tab. 

2. In the Create Geometry drop-down, choose Particle Systems. 

3. Expand the Object Type rollout and select PF Source. 
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4. In the Fountain Cam viewport, click and drag on the upper left side to create a small Particle 
Flow Source object. In this case, the size does not make any difference. 

5. Now in the Command panel, switch over to the Modify panel. 

6. With the particle flow Source Object selected, click Particle View in the Setup rollout to open 
the Particle View dialog box. 

Event setup  

Editing events 
7. Click the Birth operator in the first event. 

8. Set the Emit Start to frame 0. 

9. Then, set the Emit Stop to frame 500. 

10. Since this particle system will be a fountain, you use a particle rate instead of the total amount 
of particles. 

11. Under Options, select Rate, then set the Rate value to 300. 

12. Make sure the Subframe Sampling option is selected. This will cause 3ds Max to sample the 
particles between frames, making the birth of the particles more consistent. 

Adding Operators 

13. From the Operator toolbox, click and drag the Position Object operator on top of the Position 
Icon Operator in the event. You'll see a red line going through that operator, which means that 
operator will be overwritten. 

14. Click the Position Object operator you just added. 

15. In the Position Object rollout, you need to add emitter objects. 

16. Click By List just under Emitter Objects. 

17. In the Select Emitter objects list, hold CTRL and choose both the Pillar 1 object and the Pillar 2 
object, and then click Select in the lower right corner of the dialog. 

18. That adds these two objects into the Emitter Objects list. 

19. Check the Subframe Sampling checkbox to make the particle emission smoother and more 
consistent.  

20. In the Location group, expand the Location drop-down and choose Selected Faces. 

21. Next, click and drag the Speed By Surface operator on top of the Speed operator in the Event 
and overwrite it. 

22. Now click the Speed By Surface operator in the event. Here, you set the speed of the particles 
that will be emitted from each pillar. 

23. In the Speed By Surface rollout, expand the Set Speed drop-down and choose Set Speed Once. 

24. Set the Speed to a value of 10 feet and the Variation to a value of 1 foot. 
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25. Click By List. 

26. From the Select Surface Objects dialog box, press CTRL and select both Pillar 1 and Pillar 2, and 
then click Select. This adds the two pillars to the Surface Geometry list. 

27. Check Subframe Sampling. 

28. In the Direction group, expand the Direction drop-down and choose Surface Normals. 

29. Set the Divergence value to 3.0. 

30. Now select the Rotation operator in the event. 

31. In the Orientation Matrix drop-down, change the Orientation Matrix option to Speed Space 
Follow. 

32. Change the Z value to 1.0. 

33. Select the Shape operator from the Event. 

34. In the Shape Operator parameters expand the 3-D Shape drop-down and choose Diamond 
Long. This is a simple shape with eight faces, which will help reduce the polygon overhead when 
the scene is rendered. 

35. Change the Size to 0.5 inches. 

36. Select the Scale checkbox and leave the Scale value at 100%, but change the Variation to 5%. 

37. Now click the Display operator in the Event. 

38. Expand the Type drop-down and select Lines. 

39. Click the color swatch and set the color to a light cyan by setting the Red value to 9, the Green 
value to 215, and the Blue value to 180. 

40. Then click OK to accept the color. 

Particle Simulation and MassFX 

To start here use: 09_Pflow_Fountain_03.max 

 

1. From the Operator list, click and drag the MP Shape operator beneath the shape operator in the 
particle flow Event; you will see a blue line appear at the bottom of the shape operator. 

2. Make sure the MP Shape operator is selected, and from the Collide As drop-down, make sure 
Convex Hull is selected. 

3. Next, set the bounce and friction values. 

4. Set the Restitution value to 0.2. 

5. Set the Static Friction to 0.1, and the Dynamic Friction to 0.1 as well. 

6. Click and drag the MP World operator to the bottom of the event. 
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7. Select the MP World operator. 

8. If the option in the MP World Driver says "None," click the Create New Driver button. 

9. Once a New World Driver has been created, click the arrow icon, which is the More button, to 
the right of the world driver name. 

10. In the mP World parameters, make sure the Apply Gravity option is checked. 

11. Minimize the Particle View dialog box. 

12. Click the Play button and watch the particle flow as it is currently configured. 

13. Stop the animation, and go to frame 0. 

Adding Collisions and Tests 
14. Make sure the Particle Flow object is selected, and the Particle View dialog box is open. 

15. From the Operators list, click and drag the MP Collision operator to the bottom of the Event in 
the particle flow. 

16. Click the new MP Collision operator. 

17. In the MP Collision parameters, click the Add button. 

18. This allows you to click directly on the Granite Sphere in the Fountain Cam viewport. 

19. Click the sphere, and it is added to the Deflectors list. 

20. Select the Test True If Particles option, make sure that the Collides option is chosen. 

21. Click and drag a standard Collision operator below the mP Collision Operator. 

22. Click the second Collision operator. 

23. This time, click By List, select the UDeflector object and click Select. 

24. In the Test True If Particles group, make sure the Collides option is set and the Speed option is 
set to Stop. 

To start here use: 09_Pflow_Fountain_04.max 

 

25. Click and drag a Spawn Test Event to an open area underneath the initial Event. This will create 
a new spawn event that contains a spawn operator, as well as a display operator. 

26. Click the Spawn operator in the new Event. 

27. In the Spawn Rate and Amount group, select the Once option. 

28. Set the Offspring number to 2, and set the Variation percentage to 40%. This will create two 
particles for every one particle that collides with the sphere. 

29. Expand the Sync By drop-down and select Particle Age.  

30. In the Speed group, choose the Inherited option to set the speed to be inherited from its parent 
particle. 
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31. Leave the Inherited number set to 100. 

32. Set the Variation percent to a value of 10%. 

33. And set the Divergence to a value of 30. 

34. Click and drag a new Speed By Surface operator into the second Event beneath the Spawn 
operator. 

35. Select the Speed By Surface Event. 

36. Expand the Speed By Surface drop-down and select Set Speed Once if it is not already selected. 

37. Set the Speed value to 4 feet, and the Variation to 6 inches. 

38. Click the Add button, and choose the Granite Sphere to add it to the Surface Geometry list. 

39. Check Subframe Sampling. 

40. From the Direction drop-down, choose Surface Normals, and set the Divergence value to 5.0. 

41. Select the Display operator in the second Event, and change the Type to Lines. 

42. Choose the Color swatch, set the color to a bright yellow.  

43. Change the Red value to 225, the Green value to 225, and the Blue value to 10, and then click 
OK to accept the color. 

44. To accomplish this, click the MP World operator in the first Event, then right-click and select 
Copy. 

45. In the second Event, right-click just below the Speed By Surface operator and choose Paste 
Instanced. You should now see that both MP World operators are in italic, indicating they are 
instances of each other. 

46. Left-click the Collision for the fountain water in the first Event, then right-click and select Copy. 

47. Right-click at the bottom of the second Event and Paste the Collision operator. 

Adding a delete event. 
48. Click and drag Delete to an open area below the second Event.  

49. From the first MP collision operator in the first Event for the granite sphere, click and drag from 
the Output of the Test to the Input of the second Event. 

50. Then, click and drag from the Output of the Collision for the fountain water in the second Event 
to the Input for the third Event in order to delete the particles. 

51. Lastly, drag from the Collision operator for the fountain water in the first Event down to the 
Input of the third Event. This will delete any stray particles that bounce off of the sphere and hit 
the water directly. 

52. In any viewport, click to select the PF Source object. 

53. Open the Modify Panel, then open the System Management rollout. 

54. Change the Integration Steps for the Viewport to 1/4 Frame, and the Render to 1/8 Frame. This 
will provide adequate temporal resolution for the current particle flow. Keep in mind that you 
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don't need the same quality for the viewport, since it is just a preview of the rendered particle 
system. 

55. To see this particle flow in action, minimize the Particle View dialog box and click Play. 

56. Stop the animation and go back to frame 0. 

Caching particles 
57. You may have to scroll to the right in the Operator list. 

58. Click and drag the Cache Disk operator to the PF Source Event just below the Render operator. 
This will cause the cache to work on the entire flow.  

59. Select the Cache Disk operator.  

60. From the Sampling drop-down, choose Every Nth Frame. 

61. Change the N value to 2 and select Save Cache With File. 

62. For this cache, Click the Select Files button. 

63. Navigate to the Scenes/Cache folder, enter Fountain into the File Name and click Save. 

64. In the Particle Flow Tools dialog, click Yes to use the current location at the default cache 
location. 

65. In the Update and Reset group, click Update to update the cache. At this point a cache 
generation progress dialog opens to show you the elapsed time and time remaining for the 
cache process. 

Applying materials 

Creating and assigning a water material 

To start here use: 09_Pflow_Fountain_05.max 

 

1. Click and drag the Material Static operator into the PF Source event just below the Render 
operator. This will apply the same material to all the events with in this particle flow.  

2. To choose the Material Static operator, click the Assign Material button on the parameters 
panel. This will open the Material/Map Browser.  

3. From the Material/Map Browser, in the Mental Ray material rollout choose the Autodesk 
Water material. 

4. From the Main Toolbar, open the Slate Material Editor. 

5. Click and drag the material from the Material Static operator into the slate material editor. 

6. Choosing Instance from the Instance (Copy) dialog. Using the instance option, any changes made 
will affect the look of the particles.  
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7. In the Material Editor, double-click the Water material. 

8. Set the wave height to 0.0. This will set the water to work better for the particles in the 
fountain. 

Rendering the Fountain 

Creating a preview 
1. Right click in the camera viewport to make it the active view port.  

2. In the Tools menu, Preview - Grab Viewport option, select Create Preview Animation option to 
open the Make Preview dialog box. 

3. In the Make Preview dialog, Preview Range, keep the Active Time Segment selected, and leave 
everything else at the defaults. You can change the Visual Style to render the viewport using a 
style like Color Ink or Wireframe. 

4. In the Output section click on the Choose Codec… button.  

5. From the Video Compression dialog that pops up, use the Microsoft Video One codec and click 
OK. You can choose a different CoDec if desired, depending on what is installed on your 
particular computer.  

6. Make sure the Render Viewport is set to Fountain_Cam.  

7. Click the Create button. 3ds Max will take a little while, and you’ll see the time slider progressing 
through the frames while the preview is created.  

Rendering with Mental Ray 

Setting Motion Blur 

8. To setup motion blur, select the PF Source object. 

9. Right-click on the particle system, and choose Object Properties from the right click menu.  

10. At the lower right of the Object Properties dialog, set the motion blur to By Object. This will 
override the layer settings and use the objects motion blur options.  

11. Make sure the Enabled checkbox is checked, and the Object option is chosen, click OK to close 
the dialog. 

Render a Low Resolution Animation 

12. Click Render Setup from the Main menu to open the Render Setup dialog.  

13. In the Time Output section of the Common panel click the Active Time Segment option. 

14. Set the file location in the Render Output section by clicking on the Files… button.  

15. This opens directly into the render output directory of the current project folder.  

16. Navigate to the renderoutput folder of the 3ds Max Project folder. 

17. In the file name, type in Fountain_.png, then click save.  
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18. In the PNG Configuration dialog, set the colors to RGB 24 bit, and since there will be no need to 
render with an alpha channel, uncheck the Alpha channel option and click OK.  

19. Switch over to the Renderer tab. 

20. Make sure the Sampling Mode is set to Unified / Raytraced. 

21. In the Samples per Pixel area, leave the Quality set to 0.25, set the Minimum value to 0.25 and 
the Maximum value to 32. 

22. Leave the Contrast / Noise Threshold values at 0.2 for all the channels. 

23. Open the Camera Effects rollout, ensure that the Motion Blur option is enabled.  

24. Change the number of Motion Segments to 3. This will increase the accuracy of the motion blur 
at render time. Keep in mind that higher values will increase rendering time.  

25. Make sure the Fountain_Cam viewport is the current render view and click the render button. 

 


